Intermesh Group-Office Professional 2.15

User manual

By Merijn Schering

Group-Office™ Iatermesh

PROFESSIOMNAL .
Reitscheweg 37

5231 BX 's-Hertogenbosch
tel. +31619864268
info@intermesh.nl
http://www.intermesh.nl

KvK: 17156675



Iatermesh

Table of contents
L (1T TP TR 4
B O =T aLT £ WU =T g1 (=T - o= PP 4
2 O I 3= TP 4
2.2 Selection Of taDIES ANA ODJECIS.....cuvvveiieisrercieir ettt s R R R n e 5
2.3 TIEE SITUCTUIES ...ttt h bbb £ R bbb bbb bbbt bt 6
24 TADS. o bR E AR AR R bR R R AR b e R b bR R bR bbb E et b b e 6
2.5 PRIMNISSIONS. ... ettt ettt b bbbt bbb s E bbb £ R E £ £ R bR R b E et eR b E Rt b e 6
3 CONTIGUI YOUI BCCOUNL. ....ceuceveesctseeeiseese st seesess st ese bbb bbb bbb bbb bbb bbbttt 8
KNI o (0TRSO 8
B2 PASSWOIT. ...ttt ettt et es et s bR bk £ £ b S £ 2R E A £ AR bR b £ £ AR R b bR e e b b b e et ae bt 8
B8 PrIVACY ...t cvuteeesteeteeseteset ettt ee e eb et bbb bR R R R RS R AR R R AR R bbb 8
R 0o Q- T To T TP 9
3.4 CRANGE TNEIME .. .ceietieee ettt bbb bbb bbb R8s bbbt 9
BT L 1o [T ST 9
3.4.3 Maximum NUMDET Of FOWS N TISt.......uevevrrreerieerrieecieisisessiesisssee st ses e ess e sse st s e se s sessenssesssesnsnesesees 9
3.4.4 Multi-select rows Without USING the ‘I KEY.......c.iirieiriiererces e 9
3.5 REGIONAI SBHINGS. ...ttt bbb bbb e b bR bbb 9
3.5.1 CRANGE IANGUAGE. ... v eveireicieiieeeeee ettt ses e ses bbbt es b s s s b8 b s s8R b s sttt 9
BL5.2 THMEZONE. ...ttt ettt s bbb £ £ b £ R A4 £ b b e e e s b bRt s e s bbbttt bbbt ee b 10
3.5.3 SYNCIIONIZATION SBHINGS. ....cevuverieieiieiseire sttt bbb bbb bbb bbb 1
BT T 0111 T OO U ST 12
BRI = 1 OO OO PT PR 12
4 TG SUMMEIY ... cverteeeseeeeeseeresee et essesea st et ee b e seb e eb et b bbb b £ b e+ b £ b £ b8 b E b E b E 4 E A2 E e h e bbb Ae b E e e s bbb b e bbb b b sttt 13
5 THE AQUIESSDOOK. .. ...ttt e et e e et R E b e s e E et e s e bt es et ee et nE et e 13
o O o TSP STS T RT 14
5.2 COMPANIES. ... cvveretereie sttt ettt seb et s bbb bbb e bbb bbb 428 bR b £ £ s bbb b bbb bbbttt s 14
oI 1 =011 o= £ PO 14
o =T 4101 (- TP 14
D5 MAIIINGS. ...ttt bbbt RS R AR bR b et R bbb 16
5.6 Create @ NEW QAUIESSDOOK. .......vuevireiiieisiieieie ettt b bbb bbbttt 16
5.7 SHAre an A00rESSDOOK........ccevieeiieetiiretseietsiet ettt bbbt ee bbb bbb bbbttt ettt 16
5.7.1 Globaly ShAred a0arESSDOOK. ........cuucuuieieiiriseieieireiseie st seb st ss bbb bbb bbb bbb 16
5.8 IMPOITING CONTACES.....cv.eecveeeriter sttt ettt b bbb bbb bbbttt 17
5.9 EXPOIING CONACES. ... cvvreeeieteectee ettt ettt bbb bbb bbbt 17
D10 ACHVITIES. ...ttt sttt E R E £ E SRR ARk E Rt R et R et 18
B E-MAL... et Rt AR R AR SR £ e AR £ e AR E A A e R AR A e e R A bt R bt et e Rttt 19
8.1 Create an €-Mail ACCOUNL.......c.ciierice ettt s s bt a et bbbttt ee s 20
6.2 Edit @N €-MAII ACCOUNL........cocieiiisieiieisiriieete sttt s st e s s s s b e e s e R s e s e e st ne e s s ns et ee e snsesesssnsnnes 21
G2 T o) £ 21
B.2.2 FlEBIS vttt AR 21
Lo TR B 11 (=T o S PRRRRRN 21
6.3 COMPOSING AN B-MAUI MESSAGE. ... evuvreerereeireirerresiseieseesessesesseseseesase e sese et s bbb s s s s bbb s R bbb st sttt 22
B.3.1 AHACHMENES. ... bbbt e et 23
7 TRE CAIEBNUAL ...ttt ettt et etttk 24
7.1 Central CaleNdar DY USING VIEWS.........cucvuiuiieiiieiiiseisttstese ettt bbbttt bbb 25
7.2 CrALING CAIBNUATS. .....cuueeeeeeercereiritees ettt sttt eb st b bbb bbb h bbb bbb bbb bbb 26
7.3 SNATNG CAIBNGAIS......couvuvueereireereiseereeeiseise ettt b sse e bbb £ s bbb bbb bbb e bbb bbb 26
7.4 Create @ NEW aPPOINTMENT OF TASK........cuurerieieireisrereieiseesetseeee ettt sttt bbbttt b e 27



Iatermesh

T4 RECUIMENCE. .....evcvueeeeeseees et es s et 28

T.4.2 OPHONS. ..ottt ee bt st h £ £ £ RS RE AR 28

7.4.3 Reminder for a task or @pPPOINIMENL. ..ot b 28

7.4.4 Placing the appointment in MUItIPIE CAIENUAIS...........cueuriierie e 29

745 INVILE PATHICIPANTS. ...ce vttt bbb 29

7.4.6 AVAIIADIIITY CHECK.......cveeieisieicis ettt bbb 30

7.5 PHINEENGE CABNUAN........eeitireeiie bbb bbb bbbt 30
7.5.1 INEEIMEE EXPIOTEL......ooieece et s bbbt 30

7.5.2 MOZIHA FIPEIOX. . cv1evueencerrerererses et st s 30

7.8 BESOUICES......cocveecrcreee ettt 31
7.6.1 Creating FESOUICE GIOUPS.....cuevererrereeresetreseeeeseeseseeessesessssesstsesassessssesassessssssessssesssssssssesassesessssesassesessssssassesassessssssessssessssnsns 31

7.6.2 BOOKING @ TESOUICE......c..cueverirescier i seies sttt R 31

B TASKS. ... veseeeeset ettt R AR R 33
0 FIlBS .ttt bR R RS S RS RS R AR s R 34
0.1 INGVIGATION. ...ttt bbb 8RR R R 34
9.2 CrEAIING @ FOIHET......e vttt bbb bbb bbbt 34
9.3 UPIOAAING FIIBS... .. ettt bbb bbb 34
9.4 COPYING ANA MOVING......tteverttireerieeeeeeeesceeeseseesesesseseeseseses s e ses b sseseeses e ese b ee b st b bR bbb bbbt bbb bbbttt 34
0.5 SBAICNING. ....vvcruereeeeeeeese et r s RS R 35
9.6 Properties of files AN fOIUBTS. ... b 35
9.7 Sharing fOIAErS With OtNEI USEIS..........vuieiuririirieririieis et s et 35

0.8 TOXE BAMON ... cveseeeeeee et s R R R 35

L0 22 (0= 3 TP 36
0.1 CrEALE @ NEW PrOJECL.....vueeseesereireereteesess ettt ss bbb bbbkt 36
10.1.1 ENEEr WOTKING NOUPS.......cooeicttieisetet ettt bbbt 37
10.1.2 VIEW WOPKING NOUPS.......ceviteiiticte ettt 37

0.2 CrEALE TS ... vuieeiiteiieie ettt b bR h bbb bbbt 37
0.3 VIBW NOUPS......coeeetete ettt b bbb bbb bbbt 37
0.4 TOMPIAIES. ... vttt bbb bbb bbb bbb bbb £ b4 s bbb b £ bbb bbb bbbt 38

11 SYNCAIONIZALON. ...ttt bbb bbb bbbttt 39
11,1 MICTOSOFE OQULIOOK. ... vttt bbb bbb bbb bbbttt 39
11.2 MICrOSOft POCKEE PC 20083.........coeeiieiiieirieirie ettt bbb bbbt bbbttt 39
11.3 NOKI@ 9300/9500.......0.cvueereecrerersererersessesseseeseesesses s s s es s s s E R 39

T2 ENAING. ettt bbb bR £ E SRR AR R AR R R £ E R R R AR R R R R R bbbt et 4



Iatermesh

1 Preface

This manual is intended for the end-users of Group-Office, no extra knowledge is necessary to understand this manual. All features
in Group-Office will be covered in this manual.

The manual is written by Merijn Schering who is the owner of Intermesh and the main developer of Group-Office.

Group-Office is a groupware package consisting of a base-package to which an infinite (the server will be the limit) number of extra
modules can be added. The base-system does not contain much functionality by itself; it is the added modules which give the system
its strength and flexibility.

2 General user interface

Group-Office has been built as consistently as possible. All modules will have the same look and feel, and will ‘behave’ in the same
way. In every module the main function icons will appear at the top of the window with the rest of the module appearing beneath it.

The buttons ‘OK’, ‘Apply’ and ‘Close’ will also appear depending on the function chosen. Apply saves the changed settings in the
current window, ‘OK’ saves the changes and then closes the window and ‘Close’ closes the window without saving the changes.
Tip: In ‘Enter’ key can in most cases be used instead of the ‘OK’ button.

2.1 The Menu

In every module the menu bar is visible in the main window. With this bar you can navigate through the different modules installed on
the system. The menu bar appears as follows:

3 0 I D 2 B a

Summary Addresshook Calendar E-mail Tasks Motes Files Projects Websites
Image 1: The Menu

2.2 Selection of tables and objects

Many of the modules display information in tables. The ‘E-mail’ module for instance shows all the messages in a table. The table
always has a header displaying the description of each column in the table. By clicking on a column-name you can sort the table by
that particular information, by clicking it again, the selection is inverted.

To select an item in a row click once, to activate or open double-click. For example; clicking once on an e-mail will just display it in
the lower half of the window, double-clicking will open it in a new window.

By holding down the ‘Ctrl’ key on the keyboard while clicking on an object it is possible to select multiple items. To deselect an item
click again keeping the ‘Ctrl’ key depressed.

It is also possible to select multiple items at once. Click on the first item, press and hold ‘Shift’ then click on the last item in the row.
All items in between the first and last will be selected including the first and last one. You can also combine these two actions, for
instance you can deselect some of the items that have been marked by the ‘Shift-action’ by holding the ‘Ctrl’ key and then click on
the item you wish to deselect.

It is possible to always select multiple items without having to use the ‘Ctrl’ key, this option can be set in the Configuration menu.

In the upper left-hand corner of the table is a (square) selection box, by clicking on this box all items in the table will be selected.
All the actions available for the items selected are displayed just above the table.
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In the Configuration menu it is possible to change how many items (rows) are displayed in the table. The default is 10. If there are
more items than can be displayed on one page a navigation bar will appear at the bottom of the table. One click on the relevant
page number or the buttons ‘Previous’ and ‘Next’ will navigate to the relevant page.

B nName Status Start date ¥ End date Probability

20040017 (Summary module) Done 0373112004 0410772004 0%
20040016 (Tasks module) Done 03/20/2004 03/20/2004 0%
20040014 (Debug Group-Office) Ongoing 03M 62004 041 6/2005 0%
20040015 (Adresshbook) Ongoing 0362004 03162005 0%
20040012 (Bookmarks module) Done 0311452004 031472004 0%
20040011 (Calendar module) Ongoing 0311452004 031 472005 0%
20040010 (Documentation) Ongoing 0311452004 0411472005 0%
20040013 (Boekhouding) Ongoing 031412004 03 4/2008 0%
20040007 (Aquisition) Ongoing 02152004 0212812007 100%
20040008 (E-mail client) Ongoing 02152004 02/26/2008 100%
723 MNext==

Image 2: Standard table

2.3 Tree structures

Many modules also show their elements in tree structures. These tree structures make navigation easier. The example below is from
the ‘Files’ module. If an element in the tree has sub-elements a plus-sign is being displayed, by clicking it that part of the tree will
unfold, displaying the sub-elements. The plus sign then becomes a minus which, when clicked will collapse the tree again.

= L Personal
" 1 My Documents
[ My Pictures
= 24 Merijn Schering
= &5 Repors
[ Group-Office
Image 3: Tree stucture

2.4 Tabs

Many windows make use of tabs. Tabs can be opened by clicking on the tab label. Note that when changing to another tab all
changes on the current tab will be lost unless first saved.

2.5 Permissions

For every object in Group-Office access permissions can be set. When a new object is created, an appointment or a new folder for
files for example, the default permission ensures that only the creator of the object can view or edit the object. The owner of an
object can change the relevant permission settings. Permissions can be given to users and/or user groups. Note: When a user has
write permissions, read permissions are automatically created.

Users and user groups can be added in the standard access permission settings menu. When adding users a search function is
available. By leaving the search field blank all users are displayed. By using the ‘Ctrl’ and ‘Shift’ keys multiple users can be selected
(see section 2.2 Selection of objects).
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Use of user groups is recommended over individual users as user groups are easier to maintain.

For example; the user group ‘Intermesh’ has access to address book X', agenda ‘Y’ and folder °Z". When a new employee working
for Intermesh is added to the user group by the IT Admin department he automatically has access to the address books without
having to be added as a user in each address book individually.

Authorized groups

Admins -
Intermesh

Authorized users
Merijn Schering -

Image 4: Permissions screen
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3 Configure your account

The ‘Configuration” menu icon appears in the top right-hand corner of the main window as follows:

&, Configuration % Help @ Logout

Image 5: Top menu

By selecting ‘Configuration’ you can configure your account. Several settings can be set according to your own preference. The

selection of menu options is as follows:

Configuration
Profile

Password Firstname*  [Merijr] Company: |
Privacy Middle name: | Deparment |
Look & feel Last N Soher Function:
Regional settings astname*:  [Schering unction: |
Synchronization Title [ Initials:  [ing.
Calendar Sax: & Male © Female Street address: |
E-mail .
Birthday: portiesn .. | ZIPiPostal code: |
City:
Street address: | by |
State: |
ZIPIPostal code: |
) Country; |
City; [penBosch
Phone: |
State: [
Country: | Fax |
E-mail* |mschering@intermesh.nl
Phane: | Homepage: |
Fax: [
Cellular: [

Image 6: Profile screen

3.1 Profile

Under the ‘Profile’ menu the user’s personal information is kept. There are three mandatory fields, first name, last name and your
(business) e-mail address.

The address information in the left-hand column is intended for a private address. The right-hand column is for the business
address. After completing the information it can be saved by using the ‘Save’ button at the bottom of the window.

3.2 Password
When the system is implemented every user is issued with a general password to access the webmail system. It is strongly
recommended that this password be changed to a unique, personal password. This can be changed via the ‘Password’ menu.

3.3 Privacy

Via the privacy menu you can set which users and user groups can view your account. By default every user is hidden from other
users. You can make your account visible to others by granting permissions to other users or user groups.

If you want to grant permission to a user that doesn't appear in the search results then you can request this user to make the acount
visible to you. You can make this request by clicking 'Request authorization'. After that you must enter the user's registered e-mail
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address. The request will be sent to this e-mail address and the user can accept ior deny your request.

3.4 Look and Feel

For optimal confort the appearance and behaviour of certain things in Group-Office can be adjusted to your personal preference.

3.4.1 Change theme

The theme defines the appearance of Group-Office. Colors, fonts and logo's are all defined by the selected theme. It's possible that
the administrator has disabled this feature.

3.4.2 Start module

Via the ‘Start in module’ selection you can determine which module Group-Office displays as standard when first started.
It is recommended that this is set to ‘Summary’ as the news messages are displayed on the summary page.

3.4.3 Maximum number of rows in list

With this setting you can set the maximum number of items in a list (table), per page.
(See section 2.2 Selectionof tables and objects).

3.4.4 Multi-select rows without using the ‘Ctrl’ key

Check this option if you prefer to select multiple objects without using the ‘Ctrl’ key. This can be useful as it makes multiple selections
quicker.

Configuration

Profile

Passwaord Theme: | Professional |
SNISE Startin module: | summary =]
Look & feel

Regional settings Maximum number of rows in lists: | 25 |

Synchronization Sort names hy; I Lastname -|

Calendar
E-mail [ Multiselect rows without using the CTRL key

Image 7: Look & feel

3.5 Regional settings

In regional settings, the group office default language can be set as well the time zone, date/time notation and currency display
notation.

3.5.1 Change language

Normaly Group-Office autodetects the correct language but it could be that another language is configured in your browser. In this
case you can change the language at the login screen or you can change it at the regional settings.



Iatermesh

3.5.2 Timezone

Select your current timezone here. Be aware that when you change your timezone the appointments and tasks shift to the new
timezone. It's very important that when you make your appointments the timzone is set to the right value.

Configuration

Profile
Password
Privacy
Look & feel
Synchronization
Calendar
E-mail

Image 8: Regional settings

Language: |Eng|ish |

Timezone: Im [« Automatically adjust time to Daylight Savings Time
Date format: |I'u'|nnth.fDav_.Wear R

Date seperator: I =]

Time format: |24 hour format |

Firstweekday: Im
Thousands seperator; I—
Decimal seperator: I—
currency: le—

3.5.3 Synchronization settings

Here you can select the calendar and addresbook to sync your client with. You can only select addressbooks and calendars where

you have write permissions for. By default the data has higher priority then Group-Office. So when an appointment is changed both
at the client and Group-Office, then the appointment in Group-Office is overwritten by the client. This behaviour can be reversed by
selecting “Data from Group-Office is more important then data from the client device”.

You can also find a list of clients that have synchronized with Group-Office. If you delete a device then all data from Group-Office is

sent to the client again. Watch out for creating duplicates on your client device with this feature. If you delete this data then you also
have to reinstall your client program.

Configuration

Profile

Password

Privacy
Look & feel
Regional settings

Synchronization

Calendar

E-mail

"y e
-

Synchronize with:

"S‘“ - ~ Calendar | Merijn Schering |
yn Addresshoolk; | Intermesh (Mederlands) ;|

[T Datafrom Group-0Office is more important then the data from the guest device

Download synchronization clients

Devices
sc-pim-outlook

]
sc-pim-ppe i |

Image 9: Synchronization settings
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3.5.4 Calendar

In this menu it is possible to set the default reminder time for appointments in the calendar. This can be set from a single minute to
several weeks.

The ‘Refreshing rate’ determines how often the calendar display is refreshed thus automatically displaying appointments that might
have been added by other users.

Default access permissions can also be set for the calendar. For example you can make all appointments read-only by default, or
give write permissions only to the people involved in the appointment.

If you require tasks to be displayed in the calendar tick the “Show tasks in the calendar” box.

3.5.5 E-mail

Add unknown receivers to:
With this setting you can set whether or not an e-mail recipient not yet in your address book is automatically added to the address
book when you send an e-mail.

Ask if you want to add unknown senders to your default address book:
If you want the system to ask your confirmation prior to adding an unknown sender’s e-mail address to your address book then
check this option. A pop-up window will then appear every time you open an e-mail from somebody not yet in your address book.

Always ask receiver for a read notification by default:
If you require a read notification for every e-mail you send, check this box.

Format and Character encoding:
It is best to leave these settings to the default settings unless you understand the difference between these codes and know what
you are doing.

Activate auto reply:

It can be useful, for example when you are away on vacation, to send an automatic reply to the people that send you e-mail. You
can indicate that you are unable to respond to their mail as you are on vacation and let them know when you will return.

10
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4 The summary

This module acts as a summary for Group-Office. This page can be reached by clicking the ‘Summary’ icon in the bottom left-hand
corner of the window.

Displayed on the left-hand side of the screen is a summary of the number of unread e-mails in your in-box, your diary entries for
today and tomorrow and any tasks you have defined for today.

On the right-hand side the announcements/information is displayed.

This module is defined as the standard start module. When you log into Group-Office you will automatically see this summary page
which also gives a global overview of all the modules.

Welcome to Group-Office Merijn Schering Tuesday January 24

2 Z [

MNew e-mail Mew project  Mew note Mew evernt Mew todo

Manage announcements

) E-mail Welcome to Group-Office

You have 4 unread e-mail messages Here you can place announcements for everybody to read.

—T

Calendar

Today
[ 13:30 Smith Inc.

Tommorow
Mo events found

@ Tasks

Unfinished
[~ [] 9:00 Quote Johnson & Johnson

Tommorow
|_ |:| 9:00 Start hilling

Image 10: Summary

11
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5 The Addressbook

The address book is divided into 3 different categories, ‘Contacts’, ‘Companies’ and ‘Members'.
Companies are saved separately from the contacts, this saves much double input work.

By default the address book opens in the search screen. You can choose between the three categories and type in a key word or
click at the first letter of a first or last name (Depends on your setting at Look & Feel).

WU Wwa 2 & @ 0O [ 3

Search Contacts Companies Members Mew contact Mew company Addressbooks Templates Mﬁmings Extra datafields Delete

Search
Contacts Companies Members
ABCDEFGHIJKLMNOPQRSTUVWIXYZ
Search on: | Al fields x| for: l (Use '%' as wildcard)

Search

Image 11: Addressbook search

5.1 Contacts

A personal address book can be created in the ‘Contacts’ address book. Contacts can be added to the address book by clicking on
the “New contact” icon in the top icon-bar.

Contacts can also be added by clicking on their e-mail address within the e-mail message. Contacts can be deleted by using the
delete icon. A contact can be linked to a company.

5.2 Companies

When a company has an e-mail address it can also be added and a number of contacts relating to that company can be linked to it. If
you search for the company and then double-click on it, you will see all contacts that are related to that company. A company can be
added by clicking on the ‘Add Company’ icon in the icon bar at the top of the screen.

5.3 Members

This is the address book of the Group-Office users. Here you can find all the Group-Office users that you have permission for.

12
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5.4 Templates

With the Templates option, it is possible to make e-mail templates. It saves a lot of work and can make pre-generated signatures or
even complete messages. If you have created a template, the e-mail module will ask you whether you want to use a template when a
new message is created. If you choose to use a template the system will start the e-mail message for you.

With the Autodata option, it is also possible to make references to the address book, for instance to have the receivers first name
filled in automatically.

If you click the arrow a list with data will appear, all the data will be retrieved from the address book. Note: If data is not present in the
address book it will appear empty.

It can be useful, as in the example below, to make a template with an automatic header, for example ‘Dear + contacts last name’. If
you make a template for this, it will be filled in every time you send an e-mail with this template.

Priority: I Mormal ;[ [~ Requestthe recipientto send a read notification
Format: I HTML ~|

: [Elcode B: RBREESViv « @2 BlFIB 7 U s x L2258 EE=ES
QL ci@AO=a3%
45 Opmaak - | Lettertype - | Grootte - ;Tiv %v : Autodata -

Dear %beginning% %middle_name%%/ast_nama%,
Best regards,

Merijn Schering
Intermesh

Intermesh

Reitscheweg 37

5232 BX 's-Hertogenbosch
The Metherlands

tel. +31619864268

Image 12: Design template

13
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5.5 Mailings

Before you start using the address book it might be useful to create some groups. You can categorize groups by company or
category. This is not only organised but useful as you can select a whole group of people with one mouse click.

Click on the icon ‘Mailings’ to open the group window. You will see a summary of the groups in the current address book.

To add a group, click the ‘Add’ icon. If later you wish to delete a group, simply click the trash can icon next to the group name. To edit
the group, click the pencil icon.

D @ @& B <2 @ = #

Mew E-mail  Search e-mail Textdocument Mew project Mew note Mew event  MNew todo Upload file

Intermeash

Company profile

Mailings

Select the mailing groups where this contact helongs to

Employees [T Group-Cffice internationaal
Activities
Server [« Group-Cffice Mewsl|etter

Image 13: Select mailings

5.6 Create a new addressbook

By default an addressbook is created for each user with the same name as the user's name. It's also possible to create multiple
addressbooks. For example a personal and business addressbook. To view all your available addressbooks click at the
‘Addressbooks' button. Click at 'Add' to create a new addressbook.

Note: You need admin rights for the addressbook module to do this.

5.7 Share an addressbook

If you want to share an addressbook with another user or user group you go to the addressbook properties by clicking
‘Addressbooks' in the addressbook module. After that double click on the addressbook you would like to share. Select the tab read-
or write permissions to grant permissions.

Note: You need admin rights for the addressbook module to do this.

5.7.1 Globaly shared addressbook

It can be very useful to create one addressbook where every user can read or write to. It's best to do this as an administrator. You
create a new addressbook and share this with the right user group. This can be the special 'Everyone' group but it might be wise to

create a new group for all employees of your company. In this way a customer with an account doesn't have access to the
addressbook.

14
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5.8 Importing contacts

The addresbook can import contacts from another application. To import contacts you will have to export contacts to a comma
seperated values file (*.csv) or a vCard (*.vcf) file from the other application first. Consult the documentation of that application on

how to do this.
If you made a CVS file then you click at 'Addressbooks' from the addressbook module. Double click the addressbook where you want

to import the contacts to and select the 'Import' tab. Select the CSV file and click at 'Ok'.

The address book file you have selected will be scanned for columns containing data. You can then select which columns from the
old program should go to which columns in the webmail address book. After that you can select which of the fields will be imported
to what field in Group-Office.

After clicking on 'OK' your address book will be filled with all the data from the address book file. If you open the new address book
you will see that it has been filled with all the exported contacts information.

5.9 Exporting contacts

It is also possible to export the group office address book to a Comma Seperated Values (*.csv) or vCard (*.vcf) file, you can either
export Contacts or Companies. This process creates a file which can be used as a backup, to send it to a colleague for example or
import it into another program.

5.10 Activities

The tab activities shows the history of a contact or company. You can add files, events, tasks, projects and notes to the activities
screen by clicking at the corrosponding button. You can also select the relation from the linked item by clicking the 'Related to' button.

Mew E-mail  Search e-mail  Textdocument  Mew project  Mew note  Newevert  Newtodo  Upload file Delete

Company profile
Mailings Tasks
Employees Il Name Starting at ¥ Ending at Owner Calendars Recurrence
Activities I~ L] Taskfor Intermesh 01/24/2006 16:00 01/24/2006 17:00 Meriin Schering Merijn Schering Once
[~ [ Another task 0112412006 16.00 0112412006 17.00 Merin Schering _ Werin Schering _ Once
Calendar
B Name ¥ Starting at Ending at Owner Calendars Recurrence
| | Meeting 01/25/2006 16:30 01/25/2006 17:30 Merijn Schering Merijn Schering Once
Notes
B Name Modified at ¥ Related to
This is a note 01/24/2006 16:41 Intermesh
Projects
Filter: | Show all »| 1 project(s)
B Name ¥ Status Start date End date Probability Related to
Intermesh related project Offer 01/24/2006 01/24/2006 0% Intermesh A .gi
Files

W Name &
B Intermesh.aif Image 13 KB 01/24/2006 16:41

1item(s) Size of folder: 1,3 KB

Image 14: Activities screen
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6 E-mail

The e-mail module makes it is possible to read and compose your e-mail messages anywhere. It's also possible to configure multiple
e-mail accounts.
To start the e-mail module, click the e-mail button at the bottom of the screen.

At the left-hand side of the screen there is a tree structure with your account and folders. By default your e-mail account contains an
‘Inbox’, ‘Sent ltems’, ‘Drafts’, ‘Trash’ and a ‘Spam’ folder. Inbox contains all the incoming e-mails. Sent ltems contains all sent items,
Concepts all saved concepts, Trash all deleted items and the Spam box contains all e-mail that has been classified as spam. Note
that Group-Office doesn't classify e-mail as spam. An external spam filter should do this folder and you should create a filter to filter
the messages to the spam folder.

Compose  Search  Refresh  Delete Reply Reply all  Forward  Properties Print Previous  Close

El yw- mschering@intermesh.nl mschering@intermesh.nl - Notify (890 / 0)
) [ Inbox Move selected messages to folder.. || Mark messages... ~|
[ Verzonden items W From Subject Size Date¥
{3 Concepten -3 online-ingredients.com Welkom hij online-ingredients.com. 1,5 KB 01/23/2006 10:21
= Group-Office Group-Office usage information 1.4 KB 01/21/2006 3:55
0 Prullenbak 3 ) EASYintranet Group-Office usage information 2,6 KB 01/ 6/2006 11:41
3 Motify > EASYintranet Group-Office usage information 2,6 KB 01/16/2006 11:38
[ Offerte maken = Novax Engineering Group Office Group-Office usage information 1,8 KB 01/13/2006 18:16
3 Rsports = Group-Office Group-Office usage information 1,7 KB 0141172006 1:31
2 Group-Office Group-Office usage information 2,1 KB 11/29/2005 13:07
7 Spam 3 ) Test Mew Group-Office member registered 1,9 KB 11/28/2005 23:49
[ syncdj = Nilssons-Office Group-Office usage information 1,6 KB 11/15/2005 0:00 =
= Trash T ARF Gnania [ Frmiin PWan mmm (nfaematinn T T AdInAnnE 4 E4 E
Subject: Welkom bij From: ) Date: 01/23/2006
online-ingredients.com. online-ingredients.com <info@zorgsystemen.nl= L4 10:21

Geachte heertest,

I hent geregistreerd bij online-ingredients.com.
Wij wensen uveel success en plezier bij deze semvice.

U kuntinloggen met de volgende gegevens:

Gebruikersnaam: test L |
Wachtwoord: test

Klik op onderstaande link om inte loggen (of plak hem in de adresbalk van
uw browser). o

Image 15: E-mail screen

The larger part of the screen on the right-hand side shows the e-mail messages that are currently in the folder. If you receive an e-
mail that is still unread, it will appear in bold text.

When clicking on an e-mail just once, the content is displayed just under the list. When double clicking an e-mail message, it will
open full screen. To move multiple e-mails to another folder or to mark them as unread, read, flagged or un-flagged select the e-
mails using the CTRL and Shift keys.

If you receive a new e-mail a notify window will pop-up. By clicking on the ‘new mail’ message the e-mail module will automatically
open.
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6.1 Create an e-mail account

It's possible the administrator disabled this function. In this case you can only edit your e-mail address, sender name and signature
by clicking 'Edit account' if you have one preconfigured.

To setup a new acount you need some information from your e-mail service provider. You need the following values:

Your e-mail address

The hostname of the incoming mail server

Server type (POP-3 or IMAP)

The service port

Your username and password

In case of an IMAP server you need to know what the root mailbox is. In case you don't know this value leave it empty. If you are
having troubles with creating folders then you can try to enter 'INBOX' or 'mail' here.

IS

With this information you can create an account easily. Click at the 'Accounts' button to view your accounts. Click at the 'Add' button
to open the 'New account' screen. Fill in your sender name. This name will be displayed to receivers of your e-mail messages. After
that fill in your valid e-mail address that should be associated with this account. At last fill in the other values you got from your e-mail
service provider. If you get a ‘certificate-failure' error then tick the 'Don't validate certificate' option.

Edit account
Froperties

Mame: Merijn Schering|

E-mail; |msr:hering@intermesh.nl

Type: III'u'IAF’ >| [T 8sSL [ Dontvalidate certificate
Fort: 143

Host: localhost

Root mailbox: |

llsername: |mschering

Password: [~

Signature:

[T Automatically check this account for new mail.

Image 16: Create e-mail account
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6.2 Edit an e-mail account

If you want to edit your account then click at the 'Accounts' button from the main screen of the e-mail module. After that double click
the account you wish to edit. You will find the same screen as the new account screen. You can also navigate to folders and filters
from here.

6.2.1 Folders

Creating multiple folders is only supported by IMAP servers. Click at the 'Folders' button from the main screen or from the 'Edit
account' screen to view your folders.

It is recommended that you create the standard folders Concepts, Sent items, Trash and Spam (if not present) and select them in the
relevant boxes at the top of the screen.

If you wish to change the name of a certain folder, just click the pencil next to the folder. If you wish to delete it, use the trashcan
button, note: this will delete all messages in the folder.

6.2.2 Filters

By clicking the filters tab, it is possible to adjust e-mail filter settings. With e-mail filters it is possible to automatically move e-mail
messages to folders. For example all internal e-mails will be moved to the folder ‘Internal e-mail’.

If you wish to add a filter, click the ‘Add’ button. Select the field on which the e-mails should be sorted, fill it in and select the
destination folder.

If you wish to delete a filter, click the trash can, if you wish to edit it, click the pencil.

6.2.3 Filter spam

At many e-mail servers spam is being filtered. At the Intermesh servers messages that are probably spam are mared with
“*SPAM*™* in the subject. By creating the following filter you can easily move your spam to the spamfolder.

Please choose an action: Search criteria:

| If the subject contains: x| [rsPAMS

then move the message to folder:
fSpam A

[T Mark filtered messages as read

T BT

Image 17: Create spam filter
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6.3 Composing an e-mail message

Compose an e-mail by clicking an e-mail address link anywhere in Group-Office, the compose window will then be opened. Or
alternatively simply click the ‘Compose’ button in the top bar of the e-mail module.

A new window will open in which the e-mail can be composed. Firstly, the receivers should be specified. To select an e-mail recipient
from an address book click the “To:”, “CC:” or “BCC:” buttons.

“To”is the address / are the addresses to which the e-mail should be sent. Addresses are comma separated.

“CC” stands for carbon copy, in this field the addresses should be selected of all the contacts that need a copy of the e-mail. Note
that, the receiver can see to whom you send a copy

“BCC” stands for Blind Carbon Copy, this field is the same as carbon copy however the recipient will not see which addresses have
been selected in this field.

Ao (CC|BCC)

Next, fill in the subject line and you can now start composing the body of your e-mail. With the format button it is possible to change
the current format from HTML to text. Text is without any text format, for example bold, italic etc. but is supported by all e-mail clients.
HTML has all text format options and is supported by every regular e-mail client.

http:fflocalhost - Group-Office - Compose - Mozilla Firefox

%A To: (CC|BCO) "Merijn Schering” <mschering@intermesh.nl>,

Subject: |Gr0up—0fﬂce documentation
Priority: IW [+ Reguestthe recipient to send a read notification
Format. Im 0 files aftached Attachments
: [l code BBRES Vi A, BI:B 7 U %<
S ISR Y X =L
‘ Opmask + | Lettertype - | Grootte - i T 9
Dear Merijn,

Bestregards,

Merijn Schering
Intermesh

Intermesh

Reitscheweg 37

5232 BX 's-Hertogenbosch
The Metherlands

tel +3161 9864268
http:iwawancintermesh.nl

Bezig met het laden van localhost...

Image 18: Compose new e-mail message
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In case you have defined templates for your e-mail messages then you must select a template for your message.

Templates

Selectthe template forthis document:
Mo template

Formal

Group-0ffice information

Mewsletter

Personal

Image 19: Select template

6.3.1 Attachments

By clicking the attachment button, it's possible to attach a file to the e-mail, from either the local harddisk of your pc or the online files
in group office.
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7 The Calendar

In the Calendar you have the ability to manage all your appointments with other users. If you give other people permission to do so,

people can invite you for an appointment by placing it in your calendar or vice versa.

The calendar can be viewed per day, a few days, week or a month.
Some examples:

[ =
Nieuwe afspraak Dag weergave Week weergave Maand weergave Overzichten Agenda's

Weergave:ll‘u‘lerijn Schering | | 5dagen > << 26-09-2005 - 30-08-2005 =>

Wernieuwen Printen

September, 2005 Maandag Dinsdag Woensdag Donderdag rijciag
. 26-09-2005 27-09-2005 28-09-2005 29-09-2005 30-09-2005
(vandaag) 200
wl |Ma Di Wo Do VWr Za Zo 830 Cleijsen
35 1 2 3 4|90
36 5 6 7 8 9 10 11 1000

37| 12 13 14 15 16 17 18

38| 19 20 21@ 23 24 25|[1:00

39| 26 27 2B 29 30

12:00
Selecteer datum
13:00
Oktober, 2005 T
14:00 ansen BY.
wk |Ma Di We Do VWr Za Zo 14:30 Smit
= T 2|50

400 3 4 5 6 7 & 9

16:00

41|10 11 1z 13 14 15 16

42| 17 18 19 20 21 2z 23|00

43| 24 25 26 27 28 29 30

18:00

Selecteer datum

Image 20: Five day view of the calendar

Above you see the default view of a calendar that can show one, two, five, seven or fourteen days. The grid is confgurable for one

hour, half an hour or 15 minutes per line.

On the next page you can see the monthly view.
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Maandag

Dinsdag Woensdag Donderdag Wrijdag Zaterdag Zondag
35 29 30 31 1 2 3 4
19:30 Ricochet []10:00wWszyv [ ] 14:00 Joop Smits
8:30 Cleifter
36 5 & 7 ] ] 10 n
19:30 Ricochet |:| 11:00 Joop Smits
1300 Het Gooi
37 12 13 14 15 16 17 18
19:30 Ricochet |:| 8:00 solicitatie af
8:30 Cleiter
38 18 20 21 22 73 24 25
[] 19:30 Ricochet  [f] 9:00 Werkoverleg [ ] 12:00 Offerte
doornemen
39 26 7 28 b 30 1 2
18:30 Ricochet 10:30 Frank []14:30 dscsd 10:00 verlof [] 10:00 verlof [] 10:00 verlof [] 10:00 verlof
8:30 Cleiter fwezig 14:30 Smit
13:30 Jansen BY.

Image 21: Monthly view of the calendar

7.1 Central calendar by using views

It is possible to view your own calendar, but also to view other people’s calendars or even a complete group, by using “Views”. These
user groups are so called views, this can be a view of your whole department, for instance an Engineering department.

After choosing a view, it is possible to merge them or to view them per person.

It is strongly recommended that you use your own calendar for all your personal appointments. One central system gives a good and
accurate overview of all employees and their availability.

When you create a view you can view the different calenders merged into one view just like you would view one calendar or you can
make them appear under eachother:

Weergave:lTeam

| | Onder elkaar

| == 19-08-2005 - 23-09-2005 ==

September, 2005 Maanclag Dinsdag Woensdag Donderdag Wridag
. 19-08-2005 20-08-2005 21-08-2005 22.08-2005 23-08-2005
(vandaag) ansen, Jan 18:30 Test 5:00 Werkoverleg 18:30 Test [ ] 16:00 Factureringen [ ] 18:30 Test
wk |Ma Di Wo Do Vr Za Zo 18:30 Ricochet 21.45 Group-Office
35 1 2 3 a development chat
36| s & 7 8 o 1p 11 |[Bchering, Merin| | 19:30 Ricochet 9:00 Werkoverleg 12:00 Offerte
37| 1z 13 14 15 1 17 18 doornemen
38| 19 20 21 23 24 25 -
@ Secretariaat 9:00 Werkoverleg 14:30 Jan bellen
39| 26 27 28 29 30
Selecteer datum

Image 22: Group view of the calendar
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7.2 Creating calendars
Note: it's possible that the administrator has disabled this feature.

By default a calendar for each user with the same name as the user is created. It's also possible to create multiple calendar. For
example if you want to create a business calendar and a private calendar.

To view your available calendars click at the ‘Calendars' button from the main sceen. Click at the 'Add' button to create a new
calendar. Fill in a name and select the time period that should be showed. For example from eight till five for a business calendar.
You can also select the time scale for a calendar. Most likely you want it per half an hour.

7.3 Sharing calendars

Note: it's possible that the administrator has disabled this feature. Contact the administrator to setup permissions if this option is not
available to you.

If you wish to share your calendar double click at it from the ‘Calendars' screen. After that select the read or write permissions tab to
grant permissions to users or groups.

7.4 Create a new appointment or task

When in calendar mode you can click on a specific time on a specific day and a new appointment will be created.

To create an appointment some fields are mandatory and some fields are not. The mandatory fields are ‘Name’, ‘Type’, ‘Location’
and ‘Description’. Appointments can also be related to companies or projects and participants can be added. A timeframe for the
appointment should also be specified.

New event
Properties Recurrence Options Calendars Recources
Mame*: |De|i\rerdncumentation
Type: # Event © Todo
A Relatedto:| ﬁ'
\Q Invitees:
Location:
Description:
Starting at: |u1:25.r20u5 |12 | :|30 Rd| 2vaiabiity
Endingat  [01/25/2006 w13 = o]30 =]

[~ Timeis not applicable

Status: INeeds action =|

Image 23: Create new event or task

23



Iatermesh

7.4.1 Recurrence

It is also possible to make a repeat task or appointment over a few days, weeks, months or years, for example; every first Monday of
the month. By clicking the recurrence tab, you can make an appointment repeat itself, so that you do not have to re-enter it every
time.

New event
Properies Recurmence Qptions Calendar
Recur every: |1 | | days |

At days: I :Iv

[ Mo [ Tu[ We [ Th[ Fr[ Sa[ 5Su

Recur until: |U1.f25.f2005 | [7 Mo ending date.

Image 24: Recurring event

7.4.2 Options

You can also set some properties for the appointment/task. You can change the display colour, set a reminder for the appointment,
for instance 15 minutes prior to the appointment. The access permissions can also be set.

New event
Properties Recurrence DOptions Calendars Fecources
Reminder: | 30 || mins -]

Background: D.

PeIMISSIONS. & papicipants may modify the event
C Qnly | can modify the event
C Everybody can modify the event
" Private event

Image 25: Event options

7.4.3 Reminder for a task or appointment

A reminder can be set up in the calendar for a certain appointment or task. This can vary from 5 minutes to several weeks prior to
the occurrence. The reminder will pop up at the allotted time and will remind you about the task or appointment. It is possible to
“snooze” this reminder which will temporarily disappear and then pop up again after the set time. It is also possible to dismiss the
reminder so that it will not reappear.
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7.4.4 Placing the appointment in multiple calendars

By clicking the ‘Calendars' tab you can select the calendars where this appointment should appear in. Keep in mind that everybody
who has access to the calendars can view this appointment unless you have set this event to 'private’ at the access permissions in
the 'Options' tab.

7.4.5 Invite participants

People can be invited by putting their e-mail addresses, comma separated, in the ‘Invitees’ field. Invitees can also be selected from
the address book by clicking the address book button on the left side of the ‘Invitees’ field. All invitees will receive an e-mail with all
the information about the appointment. If an invitee is a user of Group-Office he/she will also be able to directly save it in his or her
calendar.

7.4.6 Avaliability check

There is also an ‘Availability’ button next to the start time. You can check the availability of invitees or resources by clicking this
button.You must first select the invitees, calendars or resources prior to viewing the availability.

Date: @ € [01/25/20086 |

Invitees

1 Own availability 7 a2 g 10 11 12 13 14 15 18 17 12 19 20 21 22
NN EENEEENENENNNRNNEREREEER Iﬁl [T

Calendars

[ Merijn Schering

Facturering 7 2 Q 10 11 12 13 14 15 18 17 12 10 20 21 22
O HEREERREERREERERREERREERREEEREEEEREEEREERRENRRENRERRNRERNEEEND
f 7 3 o 10 11 12 13 14 15 16 17 18 10 20 21 22
John Smith
O HEEEERRNEERENNERENEERENERNERRENRERRNERRNEEEN [[TTTTTTTTTT]
7 2 Q
[ [ [

10 11 12 13 14 15 16 17 12 19 20 21 22
1] HENNNENNNNNENEEN HEENEERENENENENENNEN

I
Merged overview
; Merged overview 7 a2 g 10 11 12 13 14 15 18 17 12 19 20 21 22
® IIIIIIII|||||IIIIIIII|||||IIﬁII LITTTTTTTTTTd
Image 26: Availability check

7.5 Print the calendar

You can print the calendar by clicking the 'Print' button. A popup screen will appear with a print view of the calendar and the print
dialog of your browser will be launched automatically.

By default most browsers are not configured to print background colors of tables. This is probably not very usefull when you want to
print your calendar. Below are instructions for chaning this setting in the most popular browsers.

7.5.1 Internet Explorer

Select “Internet options” from the “Tools” menu and select the “Advanced” tab. In that tab tick the “Print background colors and
images” option and click at “Ok”.
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7.5.2 Mozilla Firefox

From the “File” menu choose “Page settings”. Tick the “Print background (Colors and Images)” option and click at “Ok”.

7.6 Resources

It's possible to create resources in Group-Office to manage meeting rooms or company cars for example. The resources are
organized in groups and have can have administrators per group. Administrators must check and approve resource bookings.

R 8

Add Groups Delete Close
Cars
Big van Intermesh Administrator
Small car Intermesh Administrator
Meeting rooms
Meeting roam 1 Intermesh Administrator
Meeting room 2 Intermesh Administrator

Image 27: Resources

7.6.1 Creating resource groups

Note: for this option you need administrator permissions for the calendar module.

To open the resource managent click at the “Resources” button from the main calendar screen. To add a group click at the “Groups
button and after that click the “Add” button. Enter a name for the group and click at “Apply”. You can add custom fields now to the
group. For example if you want a beamer or lunch with a meeting room.

After setting up the custom field it's recommended to add an administrator to the group. A group administrator must check and
approve a booking. If you don't add at least one administrator all users can approve their bookings. Group administrators can also
create new items for their groups.

mm

Add field Delete

Meeting rooms

Froperties Write permissions Admins

Mame:™* |I'u'|eeting rooms

Ok

W Name Type
Lunch checkbox
Beamer checkbox
Mumber of participants text

Image 28: Resource group
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7.6.2 Booking a resource

Booking a resource can be done from the calendar module. When you add a new event you have a resources tab will apear
automatically when you have access to at least one resource. Select the resources you wish to use at your appointment and the
request will be sent by e-mail to the administrators of the resource group.

Properies Recurrence Options Calendars Recources
M HName Owner Status
Cars
[~ Bigvan Intermesh Administrator
[~ Small car Intermesh Administrator

Meeting rooms
[+~ Meeting room 1 Intermesh Administrator ~ Meeds action Open booking

[« Lunch
[« Beamer

Mumber of paricipants: |5

[~ Meeting room 2 Intermesh Administrator

Image 29: Resource booking

You can also view the status of your booking in the resource tab. When an administrator approves or declines your booking you will
also be notified by e-mail.
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8 Tasks

This module of Group-Office gives you the ability to compose a list of tasks. Tasks can be added to the task list and can also be
deleted. It is possible to view your own task list, but also other users task lists. The task list appears as follows:

If a task has been completed just check the box in front of it and the system will display it as done. This way, you will have a good
overview of what still needs to be done what has been completed.

It is also possible to add tasks and to delete them, as previously mentioned. If you select tasks and click on the 'Delete’ button, at the
top of the page, the selected tasks will be deleted.

If you wish to create a new task, use the ‘New task’ button at the top of the screen.

Adding a new task works in the same way as making a new appointment, see chapter 7.5.

2 &

MNews task Delete

Calendarl Merijn Schering j [« Show completed tasks

B Name Starting at ¥ Ending at Owner Calendars Recurrence
r Start hilling 01/25/2006 9:00 01/25/2006 10:00 Merijn Schering Merijn Schering Once
r D Task for Intermesh 01/24/2006 16:00 01242006 17:00 Merijn Schering Merijn Schering Once
r D Anothertask 01/24/2006 16:00 01/24/2006 17:00 Merijn Schering Merijn Schering Once
r D Quote Johnson & Johnson 12/06/2005 9:00 12/06/200510:00 Meriin Schering Merijn Schering Once
= [-] baekp 09/26/2005 09/26/2005 Meriin Schering Merijn Schering Once
2 [-] Stabatize2H4 07/21/2005 14:00 0712172005 1500 Merijn Schering Merijn Schering Once

Image 30: Task list
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9 Files

The ‘Files’ module enables files to be put online so that they can be accessed from anywhere or shared with other users. The files,
as with the e-mail system, are displayed in a tree structure. The program starts in your own personal folder.

Path: Imartin/

) A BRBLY B AP O @

Properies Mew falder Upload Delete Cut Copy Mew document E-mail Search Compress Decompress

= [t Personal W name ¥ Tvpe Size Date
(7 MyDocuments [ MyPictures Folder - 24-01-2006 15:39
. 1 My Documents Folder - 24-01-2006 15:38
1 My Pictures Group-Office Professional hosting information pdf  Adobe Acrobat PDF 299.8 KB 25-01-2006 1021
= fL Werijn Schering 3 item(s) Size of folder 200 8 KB

= =5 Repors
[ Group-Office

Image 31: Files module

9.1 Navigation

At the top of the screen the folder’s full path name is displayed. Just under it are a few buttons and below these the file system tree is
displayed. The file tree system gives a list of your own personal folders and other people’s folders that they have shared with you.
When you are in a sub folder, a button with ‘Up’ will appear which will bring you back one level in the tree. If the up button is not
available you do not have any rights to access the folder above it.

9.2 Creating a folder

To store your files in a neat way it is useful to store files in separate folders. When you want to make a new folder, first navigate to
the folder in which you want to create the new folder. The current folder is displayed as an opened folder in the tree. The path at the
top of the screen also shows you in which folder you are currently located.

To create a new folder click the ‘New Folder’ button.

A new window appears and asks you the name for the new folder. An error could appear stating that the folder already exists or if
forbidden tokens have been used, for example “/ & ?. If this is the case correct the error and try again.

9.3 Uploading Files

Uploading files operates in the same way as creating a new folder. First go to the folder in which you want to upload the files, than
click the ‘Upload files’ button and a new window will appear. In the new screen a maximum of 5 files can be uploaded from your
computer. The size of the upload is limited. The maximum you can upload is displayed under the input fields.

9.4 Copying and moving

If your folders are becoming a mess it is time to start re-organising them. This can be done quite easily with the copy and move
options in group office. First select the files or folder you wish to move. If you want to copy them click copy, if you want to move, click
Cut. The button ‘Paste’ will appear. Navigate to the target folder and click ‘Paste’.
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9.5 Searching

If you already have a folder structure, it could be useful to search a file or folder quickly. Click the search button and fill in a part of
the filename. It is also possible to specify between which dates the file was changed. If files or folders are found that correspond to
the criteria they will be displayed. Click on the location to open the folder, or click on the file or folder to open it directly.

9.6 Properties of files and folders

If you wish to change or view the properties of a file or folder first look up the file or folder in the navigator. When you have found the
file or folder, select it and click on the ‘Properties’ button.

If you click on ‘Properties’ without first selecting a file the properties of the current folder will be displayed. Properties contain the
creation date, size, location and type of the file or folder. You can also change the name or activate sharing of the folder or file.

9.7 Sharing folders with other users

It could be quite useful to share files or folder with other users of the webmail system. It is not possible to share a single file, the file
must first be in a folder that is shared with the other user. To share a folder go to the properties screen as described above and
activate sharing. Two new tabs will appear for read and write permissions. Keep in mind that all subfolder(s) will have the same
access rights as the parent folder unless configured separately.

A shared folder will have a different colour than other folders. Shared folders will automatically show up in the tree structure.

9.8 Text editor

Everywhere in the world it is possible to write a document with the text editor and save it to the online file system.
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10 Projects

With the Projects module projects are easily maintained. For the complete project group tasks and appointments can be made. Files
that are related to a project can be shared ensuring that they are available to the complete project group.
You can book working hours to a project so Group-Office can quickly calculate the costs.

10.1 Create a new project

To start a new project, click the ‘New project’ button, which is located at the top of the screen. Give the project a name and a
description, and then relate the project to a contact, company or other project. When you click on “Related to” a new popup window
will open in which the members and company’s can be selected. Select a start and end date for the project, the status of the project,
the budget and a note.

If every thing is filled in correctly, click the ‘Ok’ button. The new project has now been added to the list of projects.

Enterwarking hours

Z2 @ Z #

Mew project MNew note Mew event New todo Upload file

20040017 (Summary module)

Properties Wiew hours Activities Read permissions | Write permissions
Name:* 120040017
Description: |Surnrnan,r module
@ Relatedtn:| 5 |
Start date: |U3.f3112004 | [~ shift related appointments and tasks when | change the project start date
End date: [D4/07/2004 |
Status: IDnnE j j
Probability: I 0% |
Budget: ] £
Cwner Meriin Schering
Created at: 0373172004 9:41
Modified at: 012412006 15:36
Comments:

Image 32: Project properties
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10.1.1 Enter working hours

To enter working hours open a project by double clicking on it. Click at the 'Enter working hours' button. If you have admin
permissions for the projects module then you can select a user to enter working hours for. If you don't have admin permissions then
you can only enter wokring hours for yourself.

10.1.2 View working hours

Open the tab 'View hours' and select if you want to load hours based on an employee. If you don't have admin permissions for the
projects module then you can only view your own hours. Finally select a time period and click at 'Ok,

A B <2 @ Z #

Enterwoking hours New project New note Mew event New tadao Upload file

20040017 (Summary module)
View hours
Only load data for:

'\ Employee: | aF
Period:

* Showall
¢ Showfrom |01/25/2006 |tn 01/25/2006 |
< Showmonth|1 ;II2006 |

[ o B | oo

Activities Read permissions | Write permissions

|| Starting time Ending time Employee Project Hours Fee Break time Unit value Units
01/24/2006 8:00 01/24/2006 17:00 Merijn Schering 20040017 (Summary module) 9:00 €65,00/ 60 mins 0:00 - - jﬁ'

Summary for calendar,e-mail and tasks
01/25/2006 8:00 01/25/2006 17:00 Merijn Schering 20040017 (Summary modulg) 9:00 €6500/60 mins 0:00 - - fﬁ'

Finnished summary maodule

Summary
Total number of hours: 18.00
Total days: 2
Total fee: €1.170,00

Image 33: View working hours

10.2 Create fees

To let Group-Office calculate costprices for you the administrator must create hourly fees. Click at the 'Fees' button to create them

10.3 View hours

Click the 'View hours' button and select if you want to load hours based on an employee, project or customer. If you don't have admin
permissions for the projects module then you can only view your own hours. Finally select a time period and click at 'Ok'.
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10.4 Templates

A template can be created to simplify recurring tasks within a project. For every task a start and end time can be specified in direct
relation to the project start date.

Type: " Event ® Todo
Name™  [Make quote

Comments: [Create the quote for a customer

Todo stats: [0 »[|days  =| afterthe new project starts at[10 ~| :| 00 =]

Duration: |1 =||hours +|

Reminder: |30 || mins =

Image 34: Project template task
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11 Synchronization

Group-Office has a builtin SyncML server named Sync4GO. With this server external programs can synchronize contacts and
appointments with Group-Office. This is especially useful for PDA's and smartphones. Currently the following devices/programs are
supported:

® Microsoft Outllook 2000/2002/XP/2003
® Microsoft Pocket PC 2003
® Nokia 9300/9500

11.1 Microsoft Outlook

Download the client program at the PDA Clients section from http://www.group-office.com
Install the program by double clicking the donwloaded file

Start the installed program

Go to “Edit’->"Communication” settings en set the SyncServer URL to:

http://fill in the url that you use to open group-office in your browser here/sync/index.php
Enter your Group-Office username and password

Make sure your PC has an active connection to the Internet

7. Close the screen and click at 'Synchronize'. The first time can take some time.

>~

o o

11.2 Microsoft Pocket PC 2003

1. Download the client program at the PDA Clients section from http://www.group-office.com
8. Decompress the file with Winzip or in Windows XP with the compressed folder tool.
9. Ifthis is the first time you install the client then install the supplied package Microsoft VB Runtimes first.
10. Install the program by double clicking the setup file.
11. Start the installed program.
12. Go to “Edit’->"Communication” settings en set the SyncServer URL to:
http://fill in the url that you use to open group-office in your browser here/sync/index.php
13. Enter your Group-Office username and password
14. Make sure your PC has an active connection to the Internet
15. Close the screen and click at 'Synchronize'. The first time can take some time.

11.3 Nokia 9300/9500

The Nokia 9300 and 9500 have a SyncML client pre-installed. Instaltion of additional software is not nessecary. You only need to
confirure an Internet accesspoint before you configure the synchonization profile. Consult your Nokia documentation to find out how
to configure an Intenet access point. After you have done this take the following steps:

1. From the Desktop go to Extra->Synchronization

Press the “Menu” key and choose “New”

If the system asks you to copy the selected profile choose “No”.
Enter “Group-Office” for the profile name and press “Continue”

Select connection type “Internet”, The Internet access point and press “Continue”

IS e

Enter the following information:
Hostname: http://fill in the path you use to acces Group-Office in your browser/sync/index.php
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Port: 80

Username: your Group-Office username

Password: Your Group-Office password
7. Press “Conitnue”

8. Turn contacts on

9. Turn the calendar on

10. Turn e-mail off (You can configure your IMAP server directly_

11. Press “Continue”

12. Set the external database for contacts to “vcard” and press “Continue”
13. Set the external database for the calendar to “vcal” and press “Continue”

14. Set the profile as default and press “Ok”

The profile is ready to use with Group-Office. The first time you synchronize can take some time.

35



Iatermesh

12 Ending

This manual should contribute to a good start with Group-Office. A lot can be learned when you test the system with a couple of
users with this manual.

Intermesh wishes you a lot of fun while using Group-Office. If you have any further questions about Group-Office or this manual then
you can contact Intermesh. Go to http://www.group-office.com for more information.
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